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The WODCA Home Page has moved (1998-10-02)

The TORVS Research Team has modified his Web-Server structure. Thus, the URL for the WODCA home page has changed. The current URL for the WODCA home page is http://www2.ccc.uni-erlangen.de/software/wodca/ . If you are interested in the topic of synthesis design, you may have a look at http://www2.ccc.uni-erlangen.de/research/synthesis_design/ . This page is related to our synthesis planning program WODCA. At this site you can find a short overview about current developments. 

WODCA 3.18 for Linux (1998-08-18)

The TORVS Research Team is proud to present its synthesis planning program WODCA on the popular PC platform. Now it is possible to develop sophisticated synthesis plans without expensive workstations. The only thing you need is a PC with an additional Linux partition. It is very easy to add a Linux environment to your existing Windows or OS/2 installation. The only restriction for a successful installation of Linux on a PC is a minimum free disk space of 280 MB which is required to install a base Linux operating system inclusive WODCA and the CACTVS tools. WODCA for Linux is delivered on a single CD ROM. 

If you have further questions concerning WODCA for Linux, feel free to contact the developer via eMail: pfoertner@ccc.chemie.uni-erlangen.de. If you are interested in a test version of WODCA for Linux, please contact Prof. Dr. Johann Gasteiger via eMail: gasteiger@ccc.chemie.uni-erlangen.de. 
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�Introduction

About WODCA

WODCA is a computer program for the interactive planning of organic syntheses. It has been developed during the last nine years and further development is currently in progress. The target user group of WODCA are organic chemists in research and development working on synthesis problems. 

What can WODCA do for you?

The objective of WODCA is to assist the organic chemist in each step of the synthesis planning process. WODCA provides a series of methods and tools for chemical applications, in particular, for the planning of organic syntheses in a retrosynthetic approach. Built-in catalogs of fine chemicals like those from Acros Organics or Fluka Chemical Company provide suitable starting materials for a synthesis target. The connection between the target compound and available starting materials is achieved via methods of similarity searching. Presently, WODCA contains forty different criteria for molecular similarity, similarities specifically defined for the purposes of synthesis planning. 

Another important method for synthesis planning is the ability to search for strategic bonds to dissect a target molecule into potential synthesis precursors. Strategic bonds are defined either automatically by the program or manually by the chemist. The algorithm for the proposal of strategic bonds is based on physicochemical effects on atoms and bonds, which are calculated by published empirical methods incorporated in WODCA. Topological criteria of each bond within the query molecule are also taken into account. Disconnection of a strategic bond is followed by saturation of the open valences by additional atoms or groups in order to convert synthons into synthesis precursors. 

Usually, both methods - similarity searches and searches for strategic bonds - are used in an active interplay: if a similarity search does not directly provide a good solution, a search for strategic bonds will be initiated. This will be followed by similarity searches with the precursor molecules, then again, search for strategic bonds in these synthesis precursors, etc. until a promising synthesis has been developed. 

All methods and tools within the WODCA system are combined under an easy to use graphical user interface. WODCA supports modern features of computer interfaces like mouse control, window technique and data transfer via drag and drop. The distribution of WODCA contains the complete set of the external programs from the CACTVS system incorporated into the graphical user interface. 

�How to start WODCA

The WODCA main program is started after entering the name of a start script in a UNIX shell. The name of the start script depends on the installation type of WODCA. If you use WODCA from the distribution package, then you have to start it with wodca.sh. If you want to use WODCA in the research group of Prof. J. Gasteiger you have to start it by typing just wodca. 
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�The Graphical User Interface

WODCA's Main Window

The WODCA main window consists of certain window elements. The following scheme shows the arrangement of the window elements, e.g., the menu bar, the information area, the structure display and the console. A short description of each window element is given in the Figure 1. 



 � 

Figure 1: Arrangement of the window elements in WODCA's main window



Figure 2 shows the entire graphical user interface of WODCA at the beginning of a synthesis planning process. A target compound - shown in the structure display area - has already been loaded into WODCA. The information area indicates that the Fluka catalog composing 16,769 chemical compounds has been loaded and that the similarity search »Ring Substitution Positions« has been applied to the target compound and five potential starting materials have been found. The console gives additional output about the hits found such as the names of the compounds. 

�To obtain directly an explanation of a window element of your interest, click on the picture in Figure 2 with the left mouse button to follow the link (this works only if you use the online manual of WODCA. Of course, the printed manual of WODCA contains no links). 



 � 

Figure 2: Screenshot of WODCA's graphical user interface



WODCA's Menu Bar

The menu bar is located in the upper line of the main window. It contains seven menu entries.

 � 



�File menu

 � 

The File menu contains a Load command, a Save command, and a history function for the last five loaded or saved chemical compounds. The last option in the File menu is the Exit command. It is used to terminate WODCA. 

The File menu is used to load a molecule, a catalog of chemicals, or a match list. After clicking with the left mouse button on the Load entry a cascaded menu with the following three entries Molecule..., Catalog..., and Match List... appears: 

 � 

To load a molecule, choose Molecule... from the cascaded menu. A new dialog box for the navigation to the directory of your choice appears (Figure 3).

�

 � 

Figure 3: Dialog box to load a molecule into WODCA



The left side of the window in Figure 3 shows a listbox of Directories with all the subdirectories within WODCA's working directory. If you want to switch to an upper directory double click on the two dots in the Directories listbox. To open a directory, double click on the corresponding directory name in theDirectories listbox. The contents of an opened directory is shown in a listbox of Files on the right side of the window. Select a suitable molecule file from the Files listbox and click on the OK button with the left mouse button. 

If you have read the selected molecule file before, a new window appears to check which structure from the CTX data file you want to load. In this case, click on the First button. 

 � 

To load a catalog of chemicals, choose Catalog... from the cascaded menu of the File menu. A new window with the entire set of installed catalogs appears (Figure 4). Select a catalog of your choice and press the Load button. 



 � 

Figure 4: Dialog box to load a catalog of chemicals into WODCA



It is also possible to save a molecule which has already been loaded as a CTX file. To do so, you have to click on the Save entry in the File menu. A cascaded menu with the following two entries Molecule... and Match List... appears. 

 � 

To save a molecule, choose Molecule... from the cascaded menu. A new window appears as shown in Figure 5. 

�

 � 

Figure 5: Dialog box to save a molecule



Go to a directory of your choice and click into the Selection field. Enter a file name for the compound you want to save and press the OK button. It is recommended to add the file suffix .ctx to a molecule file name, e.g., compound.ctx

Export menu 

 � 

The Export menu manages the interaction between WODCA and the external programs of the CACTVS system. The following tasks can be carried out: 

Transfer of a molecule to the CACTVS editor to edit the chemical structure. 

Transfer of a match list to the CACTVS browser to look at the structures found in a similarity search and to display some properties like catalog index number, CAS number, package information, or the purity of the compounds.

Transfer of a target, a precursor, or a match list to the CACTVS synthesis planner to generate a graphical synthesis tree for the target compound and to manage all the structures which result from the synthesis planning process.��The Export menu can be torn off to give a permanent window. 

Searches menu 

 � 

The option Identical Structure starts a search to see whether the query compound is contained in the loaded catalog of chemicals. 

The Similar Compounds... entry is used to start a similarity search with a query structure, to look for similar compounds in a catalog of chemicals. After clicking on this menu entry with the left mouse button a new window for the application of a similarity search is shown. 

The menu field Other contains a cascaded menu with search methods like Name Search..., CAS Number Search..., (Gross) Formula search..., Atom Count Search..., and Index Range Search... . 

 � 

The option Match List Operations in the Searches menu opens a cascaded menu. 

 � 

The first entry is used to give out the match list to the WODCA console. The second one removes dublicates from the match list. 

The Strategic Bonds... entry in the Searches menu is used to evaluate strategic bonds in a query compound. If the user clicks with the left mouse button on the entry Strategic Bonds... in the searches menu, a new window for the searching and evaluation of strategic bonds appears. 

The searches menu can be torn off to give a permanent window. 

Evaluation menu 

Evaluation of match lists. Not yet implemented 

Options menu 

 � 

The Options menu is necessary to configure the Display Mode. The Display Mode controls the display of chemical structures in WODCA's Structure Display. 

If the Display Mode is set to Labels, WODCA shows no atom symbols but only atom labels. Atom labels are necessary to define strategic bonds manually. The following two pictures in Figure 6 show a target compound displayed with atom labels (first one) and with atom symbols (second one): The default value for the Display Mode is set to Atoms. 



 �  � 

Figure 6: A molecule shown with Atom Labels and Atom Symbols



The Operation Mode of WODCA can be either Expert or Novice. In Novice mode WODCA displays a help panel if a similarity search with the similarity criterion substitution pattern is selected. The help panel is shown in Figure 7. 



 � 

Figure 7: Help panel to select a similarity criterion of the type »substitution pattern«



Another feature of the Novice mode is that WODCA would quit all external programs of the CACTVS system automatically if you terminate a WODCA session. 

The switch Only Unique Matches in the Options menu influences the result of a similarity search. The catalogs of chemicals often contain the same compound in different qualities. For example, the Fluka catalog contains eleven different entries for acetone in different purities and isotopic substitution. If Only Unique Matches is activated, WODCA neglects the purity of a compound during a search and shows only one representative instead of all entries of a compound in a match list. 

The Options menu can be torn off to give a permanent window. 

Tools menu 

 � 

The Tools menu is used to start the external CACTVS programs, e.g. the molecule editor, the match list browser or the synthesis planner via a single mouse click with the left mouse button. 

The Configure ... option opens a dialog box where the names of the start scripts of the CACTVS programs have to be entered. If the paths to the CACTVS programs are not set in the user environment (see Adaptation of WODCA) the absolute paths of the start scripts have to be given in this dialog box. 

 � 

The Tools menu can be torn off to give a permanent window. 

Help menu 

 � 

The Context-Sensitive Help is not implemented yet. The Online Help starts Netscape Navigator and automatically loads the WODCA Home Page with the online manual. The About... entry shows a message box with some product information. 

 � 



Information Area and Structure Display

Two adjacent window areas with different tasks are below the menu bar (see Figure 2). The left one contains three icons for information purposes and is called the information area. The right one displays the chemical structure of the query and is called the structure display. 



WODCA's Information Area

The Catalog icon indicates whether a catalog of chemicals is loaded into WODCA or not (see Figure 2). It gives the name of the catalog and shows the total number of compounds in the catalog (e.g. FLUKA catalog presently contains 16769 compounds).

The Match List icon indicates the number of hits received from a similarity search applied to a query structure. Additionally, it gives the name of the similarity search (e.g. Ring Substitution Positions). To view a match list it has to be exported to the CACTVS match list browser, which has to be opened previously with the tools menu. The export can be achieved in different ways. It is possible to drag the match list icon with the left mouse button to the CACTVS browser window. In this case, the match list is added to the contents of the CACTVS match list browser. Alternatively, the match list can be exported to the CACTVS match list browser via the export menu. In this case, the contents of the CACTVS match list browser will be overwritten.

The Substructure icon is not yet in operation at this stage of development.

WODCA's Structure Display

The query structure and the name of the query are shown in the structure display. The query can be a target for a synthesis planning study, a precursor derived from a target structure, or a starting material for the beginning of a synthesis. The structure display uses drag & drop functionality for interaction with the external programs of the CACTVS system. Thus, it is possible to export a structure by pressing the left mouse button and dragging it to the CACTVS editor or browser window. On the other hand, it is also possible to import a chemical structure from the CACTVS browser by dragging it with a pressed left mouse button into the structure display. To import a chemical structure from the CACTVS editor into WODCA, use the editor file menu and choose the export entry. 

The structure display contains a context menu. After the right mouse button is pressed the context menu appears: 

 � 

If the option Edit Name of Compound is chosen, a dialog box is shown to set the name of the current compound. 

 � 

The option Recalculate Coordinates is only useful in some cases: Sometimes the structure display shows bad coordinates for the current compound. After clicking on this menu entry, WODCA recalculates the 2D-coordinates of the current ensemble and displays the correct coordinates. 

The option Refresh Structure Display:is seldom used: If the WODCA main window is resized or the name of a compound is edited, WODCA refreshes the structure display automatically. It is possible to enforce the structure display update with the help of this command. 



The Console

The WODCA console is located in the lower part of the main window (see Figure 2). It is a scrollable region to inform the user about the action which is presently performed . The console can also be used for manual intervention, e.g., to define a strategic bond manually. 
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�Similarity Searches

What is a Similarity Search?

The objective of a similarity search is to find suitable starting materials for the synthesis of a target compound. For this purpose, WODCA searches in a catalog of chemicals for compounds having a defined structural similarity to the query structure. WODCA contains forty different criteria for defining molecular similarity. The similarity definitions are based either on substructures such as the largest carbon skeleton or on generalized chemical reactions like oxidation or ozonolysis. Other similarity definitions combine both types of similarity criteria. 

Principle of a Similarity Search

The scheme in Figure 8 illustrates the principles of a similarity search. The user applies a similarity criterion to a target molecule and obtains a transformed target. This transformed target is compared to each transformed catalog compound, which has been precomputed for each similarity criteria during installation of the catalog. If a transformed target molecule and a transformed catalog compound are identical, then the original catalog compound is proposed by WODCA as a suitable starting material for the synthesis of the target.�

 � 

Figure 8: Principle of a similarity search



This method is very fast. A similarity search in a catalog with more than 16.000 compouns takes less than five seconds on a Sun SPARCstation10. The scheme in Figure 9 gives some examples for the effect of the application of a similarity criterion to a query compound. The transformed query compounds are compared to each transformed catalog compound to find suitable starting materials. The scheme shows only a selection of the entire similarity criteria to give an impression of the structural changes resulting from the similarity definitions. Clearly, a similarity criterion is only useful if it is adapted to the query compound. It makes no sense to search suitable starting materials for e.g. vitamin A with the criterion aromatic system including alpha atoms, because vitamin A does not contain an aromatic ring system. �

 � 

Figure 9: Selection of examples for the effect of a sililarity criterion on a query compound



�List of WODCA's Similarity Criteria

Table 1 lists the complete set of similarity criteria which can be applied to a query structure. The similarity definitions are classified as topological criteria (T) or as chemical criteria (C). The criteria "aromatic system including a-atoms", "ring substitution positions", "ring system", "rings with skeleton", and "carbon skeleton" are examples for topological criteria. The criteria "maximum reduction" or "elimination" are examples for chemical criteria. They represent chemical reactions that have a broad scope and which are applied to the query structure (see Figure 8). 

Position �Similarity Criteria �Classification ��1�Identity (full structure) �T ��2�Chiral Identity �T ��3�Biggest Molecule �T ��4�Carbon Skeleton �T ��5�Reduced Carbon Skeleton �C, T ��6�Carbon Skeleton and Alpha Atoms �T ��7�Carbon Skeleton and Alpha Atoms (Keep Aromates) �T ��8�Rings with Skeleton �T ��9�(largest) Ring System �T ��10�Ring Substitution Positions �T ��11�Reduced Ring Substitution Positions �C, T ��12�Aromatic System Including Alpha Atoms �T ��13�Element and ZH Exchange �T ��14�Maximum Reduction �C ��15�Maximum Reduction (No C Aromates) �C ��16�Maximum Reduction (No aromates) �C ��17�Carbon Skeleton with Alphas and Max. Reduction �T, C ��18�Maximum Oxidation �C ��19�Carbon Skeleton with Alphas and Max. Oxidation �C ��20�Hydrolysis (No Alphas) �C ��21�Hydrolysis (With Alphas) �C ��22�Hydrolysis and Oxidation (No Alphas) �C ��23�Hydrolysis and Oxidation (With Alphas) �C ��24�Substitution Pattern (-AR+A1-CCMB-BO-MU) �T ��25�Substitution Pattern (-AR+A1+CCMB-BO-MU) �T ��26�Substitution Pattern (-AR+A1-CCMB-BO+MU) �T ��27�Substitution Pattern (-AR+A1+CCMB-BO+MU) �T ��28�Substitution Pattern (-AR+A1-CCMB+BO+MU) �T ��29�Substitution Pattern (-AR+A1+CCMB+BO+MU) �T ��30�Substitution Pattern (-AR-A1-CCMB-BO-MU) �T ��31�Substitution Pattern (-AR-A1+CCMB-BO-MU) �T ��32�Substitution Pattern (-AR-A1-CCMB-BO+MU) �T ��33�Substitution Pattern (-AR-A1+CCMB-BO+MU) �T ��34�Substitution Pattern (-AR-A1-CCMB+BO+MU) �T ��35�Substitution Pattern (-AR-A1+CCMB+BO+MU) �T ��36�Elimination �C ��37�Elimination and Substitution (-AR+A1+CCMB-BO-MU) �C, T ��38�Carbon Skeleton with Alphas and Elimination �T, C ��39�Ozonolysis �C ��40�Ozonolysis and Substitution (-AR+A1-CCMB-BO-MU) �C, T ��Table 1: List and classification of similarity criteria



To simplify the selection of a suitable criterion of the type "substitution pattern", the parameters can be set with a help panel (see Figure 10), which is displayed if WODCA is in novice mode (see Options menu). Note, that not each combination of parameters is allowed.



 � 

Figure 10: Help panel for the selection of a similarity criterion of the type »substitution pattern«



WODCA's »Search for Similar Compounds« Window

If the user clicks with the left mouse button on the option Similar Compounds... in the searches menu the window for the use of a similarity search appears (see Figure 11): 



 � 

Figure 11: Window for the application of a similarity criterion to a target compound



The similarity search window is shown in Figure 10. It contains different window elements, which are now explained. To obtain directly an explanation of a window element of your interest, click on the picture in Figure 10 with the left mouse button to follow the link (this works only if you use the online manual of WODCA. Of course, the printed manual of WODCA contains no links). 

The left hand area is called Query (transformed). It displays the modified chemical structure of a query that has been transformed by application of a similarity criterion. The structure display for transformed queries contains a context menu with the title Query Actions. When the right mouse button is pressed the following context menu appears.�� ���The option Recalculate Coordinates is only useful in some cases: Sometimes the structure display Query (transformed) shows bad coordinates for the current compound. After clicking on this menu entry, WODCA recalculates the 2D-coordinates of the current ensemble and displays the correct coordinates.

The right hand area of the window in Figure 10 is called list box of similarity criteria. It is a scrollable region to select a criterion for a similarity search. It is not possible to select more than one criterion to combine them.

Above the list box of similarity criteria there are two switches to reduce the number of similarity criteria presented. The first switch sets the similarity range to broad, intermediate, narrow or unspecified. The second switch sets the focus of the similarity search to functionality, skeleton, rings, aromaticity or unspecified. Both switches have only an effect on the number of similarity criteria shown.�� �  �

Below the list box there are three buttons: The Search button starts a similarity search with the selected similarity criterion. If it is pressed, the structure display is updated with the transformed query and the catalog icon in the WODCA main window will display the number of hits found. To view a match list it is necessary to export it to the CACTVS browser. �The Transform button does not start a similarity search, but displays the transformed query for the chosen similarity criterion. The Dismiss button shuts the window.



How to Search for Starting Materials in a Catalog of Chemicals

Before a similarity search can be applied, a query compound has to be defined and a catalog of chemicals must have been loaded into WODCA. If a query compound is already saved in a CTX structure file, it can be loaded into WODCA with the help of the file menu. Otherwise it can be exported from the CACTVS editor to WODCA. The file menu is also useful to load a catalog of chemicals into WODCA. Whether a catalog of chemicals is already loaded into WODCA or not is indicated by the Catalog icon in WODCA's Information Area (see Figure 2). 

The next step is to click with the left mouse button on the entry Similar Compounds... in the searches menu (see Figure 2). This lets the window for the application of similarity searches appear. A similarity criterion has to be selected from the list box of similarity criteria. To start a similarity search press the Search button in the lower part of the window with the left mouse button. This makes WODCA to search in the catalog of chemicals for similar compounds which could be suitable starting materials for the synthesis of the target compound. If a similarity search was successful, WODCA lists the compounds found in the WODCA console and the Match List icon in WODCA's Information Area indicates the number of hits found which are stored in a match list. 

To view a match list it has to be exported to the CACTVS match list browser, which has to be opened previously with the Tools menu. The export can be achieved in different ways. It is possible to drag the match list icon with the left mouse button to the CACTVS browser window. In this case, the match list is added to the contents of the CACTVS match list browser. Alternatively, the match list can be exported to the CACTVS match list browser via the Export menu. In this case, the contents of the CACTVS match list browser will be overwritten. 

The picture in Figure 12 shows the result of a similarity search: 



 � 

Figure 12: CACTVS browser during the display of a match list



The match list contains 5 different compounds obtained from the Acros catalog with the similarity search »Ring Substitution Positions« (see Match List icon in Figure 2). The first three hits are displayed in the CACTVS browser (see Figure 11). The query structure was 2-methoxycarbonyl-3-phenyl-cyclopentane, which is shown in WODCA's Structure Display in Figure 2. 
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�Strategic Bonds

Organic chemists have developed a cornucopia of reactions for the construction of chemical compounds. The disconnection approach is a useful method for the development of a synthesis plan for a target molecule. Corey's synthon concept is well established for the generation of a synthesis plan in a retrosynthetic direction. The starting point of such a procedure is the target compound. The main task is to find strategic bonds for the disconnection of the target into synthons. After generation of these - usually charged - synthons they are converted into precursors by addition or removal of charged atoms or groups. WODCA is able to handle these three tasks automatically: the detection of strategic bonds, the cutting of strategic bonds, and the conversion of synthons into precursors. 

What is a Strategic Bond?

Strategic bonds are bonds within the target molecule which are qualified to be disconnected. Whether a bond is a strategic one depends on whether the bond cut leads to structural simplification in the precursors (topological criteria), and on whether the resultant precursors can easily be converted into the target by chemical reactions that have a broad scope. 

Principle of a Strategic Bond Search

WODCA offers four different approaches to search for strategic bonds. In each approach, different rules are used to evaluate strategic bonds. These approaches are now discussed in the following. 

Aliphatic Bonds Disconnection

Only non-aromatic C-C-bonds are analyzed here. Aliphatic bonds to aromatic rings are here not considered. An aliphatic bond can be either in a non-aromatic ring or in a carbon chain. Both single and multiple bonds are considered. The rating of strategic C-C-bonds considers topological criteria and calculated physicochemical parameters for the aliphatic bond being analyzed. Topological criteria are whether the bond is endocyclic or exocyclic to a ring system, whether it is a bond at a branching point, and whether it is a bond to a chiral carbon atom. 

WODCA calculates for each atom and bond within a molecule a set of empirical physicochemical parameters which are listed in the scheme in Figure 13. The results of these calculations and the topological criteria are analyzed by WODCA and are used to rate the strategic bonds. The maximum rating for a strategic bond is 100, the lowest one is a value of 0.�

 � 

Figure 13: Physicochemical parameters for the evaluation of strategic C-C-bonds



Alpha-Aromatic Bonds Disconnection

This class of strategic bonds is still in development. In the present release no evaluation is yet performed; all bonds directly connected to an aromatic ring system are considered strategic and rated with a value of 100 if this type of bonds is activated. Bonds leading from an atom of an aromatic system to a hydrogen atom are not considered as strategic. 

Carbon-Heteroatom Bonds Disconnection

The evaluation of strategic carbon-heteroatom bonds is restricted to bonds between carbon and those heteroatoms, which are embedded in a larger carbon framework, such as when the heteroatom has two bonds to carbon atoms. Bonds between carbon and heteroatoms of terminal substituents such as to halogen atoms or NH2 or OH groups are not considered as strategic. The rating of the strategic carbon heteroatom bonds depends on the functionality of the compound which is checked. WODCA is able to check C-X-bonds and a-bonds to C-X-bonds within the following organic compounds listed in Table 2:



�

Table 2: Bond types for the evaluation of strategic C-X-bonds



This list of organic compounds is not yet complete and will gradually be extended. WODCA distinguishes between s- and p-C-X-bonds and furthermore considers bonds which are in a a- position to a functional group. Usually, a-bonds to a C-X-bond of a functional group need not to be a carbon heteroatom bond. In many cases these bonds are carbon-carbon bonds (see Table 2). Often, these a-bonds are strategic, too. The assignment of a bond to a functional group is always clear. It is not possible that. for example. WODCA evaluates a carbon nitrogen double bond as an imine bond and as a part of an amidine group, simultaneously. Only one of both assignments is made, because WODCA checks not only the isolated bond but the framework in which the bond is embedded. The scheme in Figure 14 shows an organic compound with the functionality evaluated by WODCA.

�

Classification of C-X-bonds 



�

thiol bond 

thiol bond 

carboxylic acid double bond

carboxylic acid single bond

carboxylic acid alpha bond

amide double bond 

amide single bond 

amide carbon alpha bond 

amide nitrogen alpha bond 

amide nitrogen alpha bond

  

Figure 14: Example for the classification of C-X-bonds



It is important to realize that bonds 7, 9 and 10 are part of an amide group. These bonds are not classified as amine bonds. Bond 4 is a carboxylic acid single bond, not a bond in an alcohol. Bonds 3 and 6 are classified as carbonyl bonds of a carboxylic acid or an amide respectively and thus distinguished from a carbonyl bond of an ester. 

Disconnection in Polycycles

The method of searching for strategic bonds in polycyclic compounds is only useful for molecules with large condensed ring systems. A set of topological criteria based on Corey's rules for the treatment of complex ring systems is applied to the query structure. The rules are: 

strategic bonds have to be in a primary ring with four to seven ring atoms.

strategic bonds have to be in exo position to another ring system with more than three ring atoms.

strategic bonds have to be in the ring with the maximum number of bridgehead atoms.

core bonds are not strategic. Core bonds are bonds, whose disconnection will lead to the formation of primary rings with more than seven ring atoms.ring bonds between two chiral carbons are not strategic.

All this topological criteria are analyzed by WODCA and lead to a rating for strategic bonds in polycyclic compounds. The maximum rating is 100, the lowest one is a value of 0. 



The Strategic Bonds Window

If the user clicks with the left mouse button on the entry Strategic Bonds... in the searches menu the window for searching for strategic bonds appears. The Strategic Bonds window is shown in Figure 15. To obtain directly an explanation of a window element of your interest, click with the left mouse button on the picture in Figure 15 to follow the link (this works only if you use the online manual of WODCA. Of course, the printed manual of WODCA contains no links). 



 � 

Figure 15: Window for the detection of strategic bonds



The Strategic Bond window contains different window elements, which are now explained in detail: 

The left hand area is called strategic bond display. It is used for displaying a structure that is analyzed for strategic bonds. Furthermore, the strategic bonds detected in this structure and the precursors which are generated by WODCA after cutting a strategic bond, are shown in this display area. The strategic bond display contains a context menu. When the right mouse button is pressed the context menu appears.�� ���The context menu is divided into two parts. The upper part is called Strategic Bond Display and contains three checkbuttons which control the display of strategic bonds in the strategic bond display. The following two pictures show structures with strategic bonds displayed as Ratings and as Ranks. Note, that only the assignment between Ranks and corresponding bond is always clear, because it is possible that WODCA rates different bonds with the same value. To distinguish bonds with an equal rating, it is necessary to switch the strategic bond display to Ranks.�� �  ���The lower part of the context menu is called Target Actions and offers four menu commands which enable operations on the structure in the strategic bond display.��Tautomerize Precursor(s): This command enables the tautomerization of the generated precursors. Since the tautomerization step is not automatically performed, the user has the choice to work with tautomeric precursors or not. The scheme in Figure 16 gives an example for that.�

 � 

Figure 16: Example for the tautomerization of precursors generated by WODCA



Delete Strategic Bonds: After applying this command all strategic bond definitions within the query molecule will be deleted.�Recalculate Coordinates: Sometimes, a structure in the strategic bond display has coordinates for the generated precursor that are not pleasing to a chemist. After clicking on this menu entry, WODCA recalculates the 2D-coordinates of the precursor structure and displays the coordinates in a more esthetic fashion.�Refresh Structure Display: If the strategic bond window is resized, WODCA refreshes the structure display automatically. It is possible to enforce the structure display update by clicking on this menu option. 

The right hand area of the strategic bond window in Figure 15 is called strategy list box . It is a scrollable region to select a strategy for the search and evaluation of strategic bonds. It is not possible to select more than one strategy for combination strategies. However, it is possible to apply different strategies one after the other to work through all the strategic bond definitions resulting from different strategies (see Configure... button below).

The action area is located in the lower part of the strategic bond window (see Figure 15). It is divided into a larger left side and a smaller right side. The left side contains four buttons, one switch, and one entry field. The right side contains two buttons. The picture shows the isolated action area with activated buttons on the left side.�� � ��The meaning of the different control elements in the action area is explained in the following. First, we start with the buttons on the left side of the action area.��Search Bonds button: After the selection of a suitable strategy from the strategy list box, WODCA is ready to search for strategic bonds. To start the search just click on the button Search Bonds. The result of the search is shown in the strategic bond display.�� ���List Bonds button: After WODCA has searched and evaluated strategic bonds, this button allows the listing of strategic bonds in the WODCA console. If no strategic bond is defined this button is inactive and cannot be pressed.�� ���Cut Bond button: After WODCA has searched and evaluated strategic bonds, this button allows the disconnection of one or more strategic bonds. If WODCA has found more than one strategic bond within the query molecule, it is necessary to select either one strategic bond or a set of strategic bonds, which should cut by WODCA. The selection is done by using the switch or entry field (see below) in the action area. After pressing the Cut Bond button, WODCA cuts the selected strategic bond(s) and displays the generated synthesis precursor(s) in the strategic bond display. The following example shows a precursor generated by WODCA after cutting the bond rated with »97«.�� ���If no strategic bond is defined, the Cut Bond button is inactive and cannot be pressed.��Undo Cut button: If a strategic bond is cut by WODCA this button makes it possible to cancel the bond cut. If no strategic bond is defined the Undo Cut button is inactive and cannot be pressed.��The switch Selected Bond enables the selection of one strategic bond which should be cut after pressing the Cut Bond button. The default value of the switch is 1. It is important to note that only the rank of a strategic bond is considered. If one is interested in cutting a strategic bond, it is recommended to display strategic bonds as ranks, not as ratings (see context menu of the strategic bond display), because the assignment of a rank to a corresponding strategic bond is always clear in contrast with the assignment of a rate to a strategic bond, because several bond cuts may have the same rating (see example above: Two strategic bonds are rated with »48«).��The entry field Set of Bonds enables the selection of more than one strategic bond. Thus, it is possible to cut a set of strategic bonds simultaneously after pressing the Cut Bond button. To define a set of strategic bonds click into the entry field and enter the ranks of the strategic bonds you wish to combine. Each rank has to be separated from another one by a space.��The right sight of the action area contains only two buttons:��Configure... button: After this button is pressed, a new window for the configuration of the strategic bond window appears as follows:�� ���Dismiss button: This button shuts the strategic bond window.

Manual Definition of Strategic Bonds

To manually define a strategic bond it is necessary to set the display mode in WODCA's Structure Display from atom symbols to atom labels (see Options menu). 



 � 

Figure 17: Chemical compound displayed with Atom Labels



Using the sbond command within the WODCA console it is possible to manually define a strategic bond. The syntax of the sbond command is: 

sbond {atom_label_1 atom_label_2} -add {element_1 element_2}

atom_label_1 and atom_label_2 are the atom labels of the bond, which shall be defined as strategic. element_1 and element_2 are the elements, which shall be added to the open valences of the atoms 1 and 2, respectively, of the bond which should be cut. 

The following example illustrates the use of the sbond command. If the user wants to define the bond between atom 2 and atom 7 of the structure shown in Figure 16 as strategic to generate the precursors of a Friedel-Crafts-reaction between a benzene ring and a cyclopentane derivative, he / she has to enter the following command in the WODCA console: 

sbond {2 7} -add {H Br}

After pressing the Cut Bond button, WODCA generates the following precursors shown in Figure 18. 



 � 

Figure 18. Strategic bond window with two precursors generated after a manual bond cut
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�Technical Information

Preface

Thank you very much for your great interest in WODCA and CACTVS. WODCA is a computer program of the newest generation for the interactive planning of organic syntheses. Together with the CACTVS tools it allows powerful planning studies of organic syntheses on UNIX-Workstations with IRIX, Solaris or Linux as operating system. 

For a successful installation of WODCA and CACTVS read this document carefully before you begin the installation process. A detailed description of the installation is given in the section Installation Step by Step. 

Test License

If you are interested in a test version of WODCA or your test license of WODCA runs out, send an email to gasteiger@ccc.chemie.uni-erlangen.de and ask for a license prolongation. Please tell us on which hardware environment do you wish to install the program. Usually, the test license of WODCA is limited to a period of six months. After this period the program will not start any more. The test version of WODCA on the current CD ROM distribution will run until Feb 28, 1999. 

About the Installation Media

WODCA is delivered on a single CD ROM. The CD ROM contains all necessary files for a WODCA / CACTVS test installation. Additionally, the CD provides the Janssen catalog of chemicals in an electronical form. Further catalogs of chemicals are available by inquiry. 

On the CD ROM the following files and directories can be found: 

README.TXT

English installation guide 

/wodca

This directory contains two files:�tcl-tk-IRIX5.3.tar.gz�wodca-3.18-IRIX5.3.tar.gz

/janssen

This directory contains all files for the JANSSEN catalog of chemicals. The file JANDIR-2.0.tar.gz serves as a backup file of the /janssen directory and is not necessary for the work with the catalog. It enables a complete restore of the /janssen directory. 

/cactvs

This directory contains only one file:�cactvstools-IRIX5.3-3.10.tar.gz

/tools

This directory contains two utility programs for IRIX 5.3:�gunzip�tar�If you do not have installed these two programs in your UNIX environment, you can use them from the CD ROM. These utilities are necessary to restore the installation from the *.tar.gz files. 

/examples

This directory contains example files taken from a synthesis planning study with WODCA. The following structure files are included�target.ctx�prec1.ctx�prec2a.ctx�prec2b.ctx�prec3.ctx�These files can be loaded by WODCA or CACTVS editor/browser and viewed by these programs. 

/html

This directory contains the complete manual for WODCA written in HTML. To view the manual you need a WWW browser like Netscape Navigator 2.02 or higher. The online manual is composed of the following HTML files which are listed in a chronological order:�index.html�whatsnew.html�intro.html�gui.html�simsearch.html�sbonds.html�cactvs.html (sorry, not yet written)�work.html (sorry, not yet written)�reference.html (sorry, not yet written)�install.html�It is recommended to use the online manual from within WODCA (see Help Menu), because this one is the most current. But if your firm has an internet firewall and no connection to the WODCA Home Page is possible, you can use the manual on the CD ROM as a substitute. In this case, it is recommended to copy the complete directory /html to your local hard disc and adapt the configuration file .wodcarc (see Adaptation of WODCA). 

Hardware and Software Requirements

For a successful installation of WODCA and CACTVS from the CD ROM you need at least one of the following environments: 

Silicon Graphics workstation with IRIX 5.3 or higher

Sun workstation with SunOS 4.1 or higher

Sun workstation with Solaris 2.4 or higher

PC with Linux 2.0.

WODCA was tested on workstations with IRIX 5.3, IRIX 6.3, IRIX 6.4, Solaris 2.4, Solaris 2.5, and SunOS 4.1, and on Personal Computers with Linux kernel 2.0. 

Installation Step by Step

Installation of the CACTVS tools

Create a temporary directory (e.g. /demo/temp) and an installation directory for WODCA and CACTVS (e.g. /demo/bin) on your local hard disc or network drive.

Put the CD ROM in a CD ROM drive and mount it from your SGI workstation. Go to the CD ROM directory /cactvs and copy the backup file cactvstools-IRIX5.3-3.10.tar.gz to the directory /demo/temp on your local hard disc, e.g.��cp cactvstools-IRIX5.3-3.10.tar.gz /demo/temp

Go to the directory /demo/temp on your local hard disc and unpack the file cactvstools-IRIX5.3-3.10.tar.gz with the following command:��gunzip < cactvstools-IRIX5.3-3.10.tar.gz | tar xvf -

Now, start the installme script which has been created in /demo/temp, e.g.��/demo/temp/installme

During the installation process two path names have to be given. The first path is the place, where the subdirectory cactvs shall be created (e.g. /demo/bin), the second path is the place, where the starting scripts shall be created (e.g. /demo/bin).

With these starting scripts the programs of the CACTVS system can be launched. To test the installation of the CACTVS tools, go to the directory named above (e.g. /demo/bin) and start the CACTVS programs with one of the following commands:��csed��(starts the CACTVS molecule editor)��csbr��(starts the CACTVS match list browser)

After a successful installation of the CACTVS programs, the directory /demo/temp on your local hard disc should be deleted.

Installation of WODCA with the JANSSEN catalog of chemicals

Put the CD ROM in a CD ROM drive and mount it from your SGI workstation. Go to the root directory of the CD ROM and copy the directory /wodca to your local hard disk or network drive, e.g.��cp -r wodca /demo/bin

Go to the directory /demo/bin and set write permission to the directory wodca, e.g.��chmod +w wodca

Go to the directory /demo/bin/wodca and unpack the file tcl-tk-IRIX5.3.tar.gz with the following command:��gunzip < tcl-tk-IRIX5.3.tar.gz | tar xvf -��Do the same with the file wodca-3.18-IRIX5.3.tar.gz, e.g.��gunzip < wodca-3.18-IRIX5.3.tar.gz | tar xvf -

To install the JANSSEN catalog of chemicals, copy the /janssen directory from the CD ROM to your local hard disk or network drive, e.g.��cp -r janssen /demo/bin��The file JANDIR-2.0.tar.gz serves as a backup file of the /janssen directory and is not necessary for the work with the catalog. It enables a complete restore of the /janssen directory. To save disc space, it is recommended to delete the file JANDIR-2.0.tar.gz from the directory /demo/bin/janssen, e.g.��rm /demo/bin/janssen/JANDIR-2.0.tar.gz

It is necessary to set some environment variables to the starting script of WODCA. Thus, go to the directory /demo/bin/wodca and edit the file wodca.sh in the following way. For the environment variables CACTVSHOME and WODCAHOME the corresponding absolute paths have to be set, e.g.��CACTVSHOME=/demo/bin/cactvs�WODCAHOME=/demo/bin/wodca

The file cspl is also located in /demo/bin/wodca. It is used to invoke the CACTVS Synthesis Planner. Edit this file in the same way to set the environment variables CACTVSHOME and WODCAHOME, e.g.��CACTVSHOME=/demo/bin/cactvs�WODCAHOME=/demo/bin/wodca

The file /demo/bin/wodca/WLIBS contains the absolute paths to the catalogs of chemicals implemented in WODCA. All catalogs not been included in this distribution should be deleted from this file. However, the absolute path of the Janssen catalog has to be adapted, e.g.��/demo/bin/janssen/JANDIR

The WODCA core program is now ready to start and can be launched with the command wodca.sh from the directory /demo/bin/wodca, e.g.��/demo/bin/wodca/wodca.sh��Note, that at this time the installation process is not finished! Before WODCA is ready to use, a few things still have to be adapted (see Adaptation of WODCA).

WODCA's working directory

If WODCA is started for the first time, a WODCA subdirectory in the user's home directory is created automatically, e.g. /home/user/WODCA. Furthermore two configuation files are copied from /demo/bin/wodca to WODCA's working directory /home/user/WODCA. The first one is the hidden file .wodcarc, the second one is named profile. With these two configuration files each user of WODCA is able to adapt WODCA to his / her needs. 

It is recommended to use WODCA's working directory to organize all the structure files, which are generated during the work. For each new synthesis planning study the user should create a new subdirectory, where the synthesis target, precursors and match lists are saved, e.g. 

/home/user/WODCA/study1�/home/user/WODCA/study2�/home/user/WODCA/study3

Adaptation of WODCA

.wodcarc

The hidden file .wodcarc enables the adaptation of WODCA's color scheme of the graphical user interface, the configuration of the display of strategic bonds, and the setup of the paths to the external programs of the CACTVS system. Furthermore, it defines the location of the online manual, which shall be used during the work with WODCA. 

The hidden file .wodcarc is located in WODCA's installation directory /demo/bin/wodca. It is copied during the first start of WODCA to WODCA's working directory /home/user/WODCA. The first path has a lower priority than the second one. Thus it is possible that every user of WODCA adapts the file .wodcarc, located in /home/user/WODCA to his / her needs. 

It is recommended that the system administrator sets the default values to the file .wodcarc located in WODCA's installation directory before WODCA is started for the first time. In this case, the adapted file .wodcarc is copied to the user's working directory of WODCA and there will be no necessity to adapt the file again unless the user wants to define his / her own color palette for WODCA. 

The following lines show the structure of the file .wodcarc: 



! `.wodcarc'

!

! A general X resource file for tk based applications.

! This one is for the WODCA3 core system.

!

! General widget colors:

!

Wodca*Foreground:   black

Wodca*Background:   light steel blue

Wodca*activeForeground:   white

Wodca*activeBackground:   steel blue

Wodca*highlightBackground:  light steel blue

Wodca*troughColor:   pale turquoise

Wodca*Canvas.Background:  gray40

Wodca*Entry.Background:   pale turquoise

Wodca*Listbox.Background:  ivory

Wodca*Text.Foreground:   black

Wodca*Text.Background:   ivory

Wodca*Radiobutton.activeBackground: steel blue

Wodca*Scrollbar.activeBackground: steel blue

Wodca*Listbox.selectForeground:  white

Wodca*Listbox.selectBackground:  steel blue

!Wodca*Scrollbar.Foreground:  Light Steel Blue

!Wodca*Scrollbar.activeForeground: LightPink1

Wodca*selectColor:   deep pink

! standard: #b03060

!

! Special widget colors:

!

Wodca*pic.Background:   light steel blue

!

! Colors for molecular drawings:

!

*bondColor: white

*carbColor: white

*haloColor: green

*hydroColor: PaleTurquoise1

*nitroColor: deepskyblue

*oxColor: red

*phosColor: orchid

*sulfColor: yellow

*textColor4: white

!

! Special ressources for the display of strategic bonds:

!

*markerColor: yellow

*markerWidth: 3

*drawMode: ratings

!

! Resources to define the paths to the external CACTVS programs:

!

*editorCmd: csed

*browserCmd: csbr

*plannerCmd: /home/wodca3/bin/cspl

*editorName: Cactvs/Editor

*browserName: Cactvs/Browser

*plannerName: Cactvs/Planner

!

! Resources to configure the online help:

!

*manualBrowser:

*manualURL:



It is important to check the section »! Resources to define the paths to the external CACTVS programs«. If the CACTVS tools are installed in /demo/bin/cactvs and WODCA is installed in /demo/bin/wodca, it is necessary to adapt the following entries as shown in the example: 

*editorCmd: /demo/bin/csed�*browserCmd: /demo/bin/csbr�*plannerCmd: /demo/bin/wodca/cspl

The section »! Resources to configure the online help« is used to define an alternative WWW browser to Netscape Navigator and another URL for the location of the online help. The default values for the variables *manualBrowser and *manualURL are netscape and http://www2.ccc.uni-erlangen.de/software/wodca/contents.html. Thus, if Netscape Navigator is installed in your UNIX environment and your firm has an unlimited access to the internet, then you will not need to change anything and the fields *manualBrowser: and *manualURL: can be empty. 

But if an alternative WWW browser instead of Netscape Navigator shall be used to see the online help, the variable *manualBrowser: has to be changed to the start script of the alternative WWW browser, e.g. 

*manualBrowser: mosaic

If your firm has an internet firewall and the online manual is copied from the CD ROM directory /html to a local network drive, e.g. /demo/bin/html, then the variable *manualURL: has to be adapted, too. 

*manualURL: file:/demo/bin/html/contents.html

�profile

The file profile enables the selection of a default catalog of chemicals which shall be automatically loaded during the launch of WODCA. Furthermore, it initializes a welcome message in the WODCA console after WODCA is started. 

The file profile is located in WODCA's installation directory /demo/bin/wodca. It is copied during the first start of WODCA to WODCA's working directory /home/user/WODCA. The first path has a lower priority than the second one. Thus it is possible that every user of WODCA adapts the file profile, located in /home/user/WODCA to his / her needs. 

It is recommended that the system administrator sets the default values to the file profile located in WODCA's installation directory before WODCA is used for the first time. In this case the adapted file profile is copied to the user's working directory of WODCA and there will be no necessity to adapt the file again unless the user wants to define another catalog of chemicals as the default one. 

The following lines show the structure of the file profile: 



#

# `profile' - default start-up file for the Wodca core system

#

&lt;BR&gt;

# Print a welcome message:

write2shell &amp;quot;\t+---------------------------------------------------------------+\

\n\t|                 Welcome to the WODCA system !                 |\

\n\t|                                                               |\

\n\t|                     Face the challenge !                      |\

\n\t+---------------------------------------------------------------+\n&amp;quot;

&lt;BR&gt;

# Open a catalog at startup time

set catalog /db/catalogs/FLUKA/Fluka

catalog -open $catalog

&lt;BR&gt;

proc dbs {} {

foreach db {VORHER MOLINF NACHER} {

write2shell &amp;quot;$db: `[ens get $db A_LABEL]'&amp;quot;

}

}

proc fs {} {

foreach f [molfile list] {

write2shell &amp;quot;$f: [molfile get $f format mode record name]&amp;quot;

}

}

&lt;BR&gt;

# EOF



To change the default catalog of chemicals edit the file profile in the following matter. Define the desired catalog of chemicals by using the 'set-statement', e.g. 

# Open a catalog at startup time�set catalog /demo/bin/janssen/JANDIR�catalog -open $catalog

Now, WODCA loads automatically the JANSSEN catalog of chemicals during the launch. 

Support

For further information referring to the installation of WODCA please contact: 

Matthias Pförtner�Computer-Chemie-Centrum �Institut für Organische Chemie �Universität Erlangen-Nürnberg �Nägelsbachstr. 25 �D-91052 Erlangen �Germany 

Tel: +49-9131-85-2-6578�Fax: +49-9131-85-2-6566�Email: pfoertner@ccc.chemie.uni-erlangen.de
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